Metric Optimization

The Metric Optimization, on page 2 tool optimizes metricsin the network core. It replaces the IGP metrics
of core interfacesin a network plan with new metrics chosen to maximize the throughput achievable by the
resultant routes, under a specified set of failure scenarios.

The Tactical Metric Optimization, on page 4 tool lets you quickly fix local congestion by doing as few
maodifications as possible on selected interfaces to push utilizations under a given level.

Note The core of the network must be connected, and all nodes must be contained in one AS. That is, there must
be a path between any two core nodes that passes only through other core nodesin the same AS, and not
through edge nodes. If thisis not the case, Metric Optimization signals an error.

This section contains the following topics:

« Core Versus Edge, on page 1

» Metric Optimization, on page 2

* Tactical Metric Optimization, on page 4
* Reports, on page 5

Core Versus Edge

WAE Design plan filesallow nodesto be defined as either core nodes or edge nodes. Note that these definitions
arenot related to any explicit router configurations. A similar classification of circuitsis determined implicitly
by the nodes they connect. If acircuit is attached to one or more edge nodes, it is defined as an edge circuit.
Otherwise, itisacorecircuit. Edge metrics and core metrics mean metrics of edge or core circuits, respectively.

This core and edge distinction helps define certain policies followed by WAE Design tools. In Metric
Optimization, these are as follows:

* Only core metrics are changed.
« The objective isto minimize utilization in the core. Utilization in the edge is not taken into account.

* The routes selected by the metrics are restricted by the tool so that any route between a source and a
destination will enter the core at most once, and leave the core at most once. That is, edge leakage of
routesis prevented.
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A consequence of these policiesisthat larger edge metrics in the plan file to be optimized might result in
better optimized core routes. With larger given edge metrics, the Metric Optimization tool has more flexibility
in how it can set the core metrics without |eakage of routes into the edge.

Metric Optimization

There are many trade-offs in metric optimization. The main trade-off is between performance under normal
operation versus performance under failure. Metrics can be selected to do well under the former whileignoring
the latter, or to try to balance performance between the two.

M etric optimization optimizes undifferentiated traffic, but does not optimize traffic per service class or per
interface queue. If there are policies set on the undifferentiated traffic, WAE Design tries to minimize both
the interface utilization and the policy violations.

Step 1 Choose Tools > Metric Optimization.

Step 2 Decide on the normal (non-resilient) optimization options to use. (See Table 1: Metric Optimization Options, on page
2 for field descriptions.)

Step 3 Decide on the failure (resilient) optionsto use. (See Table 1: Metric Optimization Options, on page 2 for field

descriptions.)

For planning purposes, the most benefit from metric optimization isthat it is able to optimize routing over alarge number
of failure scenarios. This capability controlsthat optimization, aswell as control s the trade-off between normal and failure

optimizations.

Step 4 Specify the remaining options to fine-tune the optimization, and then click OK.

What to do next

Table 1: Metric Optimization Options

Field

Description

Normal (Non-Resilient) Options

M inimize maximum interface
utilization

This default is usually the primary objective, and concentrates on reducing the utilization of the
interface with the highest utilization.

Minimize # of interfaces with
utilization > x %

Often asmall number of interfaces are bottlenecks in the network, and their utilizations cannot be
reduced through rerouting. However, it is still desirable to reduce the utilization of other,
under-utilized interfaces. This option triesto reduce all interface utilizations to below a specified
utilization level, or, if thisis not possible, to minimize the number of interfaces over thislevel.

Minimize average latency

If after the optimizations flexibility is available in the choice of metrics, WAE Design uses this
flexibility to minimize the average latency of the routes across the network. Thisis not
user-configurable and is always on.

Enforce latency bounds

If checked, the choice of paths for each demand is restricted, if possible, to those demands with
latency below the latency bound.
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Field

Description

Failure (Resilient) Options

Minimize maximum interface
utilization

If checked, WAE Design selects metrics to minimize the maximum interface utilization over all
interfaces and all failure scenarios. If unchecked, only normal operation is optimized, and the
remainder of the failure section isignored.

Minimize # of interfaces with
utilization > x %

Thenumber of interfaceswith utilization (under any failure scenario) above a specified percentage
is minimized.

Enforce no-failure utilization
bound

If unchecked, maximum failure utilization is minimized with no consideration for utilization under
normal operation. It is often convenient to check this option and place a bound on the utilization
under normal operation, which Metric Optimization then satisfies, if possible.

Failures to consider

This option determines the failure scenari os over which optimization is performed. You can select
any combination of failures.

« All unprotected circuit, node, Layer 1 (L1) node, and L1 link failures

* All SRLG failures
This option does not consider port or port circuit failures. For information on protecting objects
from being included in this analysis, see Simulation Analysis.

To control the number of threads that WAE Design processes in parallel when examining failure
scenarios, set the Maximum number of threadsfield.

Other Options

Optimization Type

WAE Design can perform global or incremental metric optimizations.

* Incremental—Uses the current routes as a basis from which improvements can be made. The
target routes are not changed as radically as when using global optimizations, and therefore
the number of metric changes from the metric targetsis typically much smaller using the
incremental option.

* Global—Creates optimal routes from scratch, and targets the old metrics afterward. Because
WAE Design can choose routes globally, this option tends to perform better under some
circumstances, particularly when the target routes are poorly chosen. However, global
optimization typically takes longer than incremental optimization.

Set Metrics on Interfaces

By default, WAE Design sets or changes metrics on any of the core interfaces in the network to
achieve its optimization goals. Alternatively, as provided by this option, Metric Optimization
restricts metric changes to the following interfaces: all, core, selected in table, or tag name.

Traffic Level

The traffic level over which the optimization is performed.
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Field Description

Interfaces to Optimize By default, WAE Design optimizes all interfaces. You can restrict the optimized interfaces using
this option and choosing the Optimize utilization on interfacesvalue: al, core, selected in table,
or tag name.

For those interfaces that are not optimized, you can set the following:
* Ignore
« Minimize number of interfaceswith util > %

* Minimize number of interfaceswith util > current + %

Target to Current Metrics There are many sets of metrics that will result in equivalent sets of routes. (Doubling all metrics,
for example, does not change routes.) WA E Design sel ects between these sets of metrics by metric
targeting. Metrics can be selected to match as closely as possible the current metricsin the network.
This simplifies the changeover from one set of metrics to the next.

Targeting optimized metrics to the current metricsin the plan is performed by default. Various
targeting refinements are available as CLI options to specify upper and lower bounds on metric
selections.

Enforce Symmetric Metrics This option sets the two metrics on each interface of each circuit equal to one another. This
constraint can reduce optimization performance. However, it ensuresthat demandsfrom A (source)
to Z (destination) and from Z to A (in the core) take the same path, and so the chances of a session
between A and Z being interrupted by afailure is minimized.

Prevent Edge L eakage This default option restricts how WAE Design can change demand routes. |f a demand starts by
routing only through the core, or from the edge through the core to the edge, this option prevents
the routing from being changed so that it routes through the edge in the middle of its path. Thisis
usually adesired routing policy restriction.

Simulate after optimization Thisdefault option performsasimulation analysis after optimizing metrics. Thesimulation analysis
allows adetailed view, for example, of the utilizations under failure resulting from the new metric
settings.

New Plan for Result This default option creates a new plan as aresult of running Metric Optimization. Unless a name

is specified, WAE Design attaches the suffix -mopt to the plan filename. If not selected, WAE
Design changes the current plan file with the updated information.

Tactical Metric Optimization

The Tactical Metric Optimization tool (Tools > Tactical Metric Optimization) is areduced version of the
Metric Optimization tool that minimizes the number of changes and runs faster. The options for thistool are
a subset of those for the Metric Optimization tools.
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Set Metrics on Interfaces: |Core T]

Minimize number of interfaces with utilization = 100 T

Interfaces to Optimize... l

Traffic level: Selected: morning -

[¥] Time Limit: 600 seconds
| Enforce latency bounds

r Enforce Symmetric Metrics

3B1067

[¥] New Plan for result:  euro_akd-mopt

Thetool triesto find the most optimal solution it can. In general, the longer it runs, the better the result. The
Time Limit option tells the tool to stop looking for better solutions after the specified amount of time, and
use the best solution it has found so far. If the option is not set, the tool continues to run until it runs out of
solutions to explore, which can take along time. If you need all available solutions to be explored, use the
Metric Optimization, on page 2 tool.

Metric Optimization writes a Metric-Opt report to the Design History area of the Reports window. To access
thisinformation later, choose Window > Reports.

Metric Optimization Report

Warnings

* Options—Summarizesthe options used to call Metric Optimization. Some of these options (for example,
the Output file and Report file) are only relevant when using the CLI tool.

* Number of demands—Total number of demands in the plan.

* Objectives—Summarizes the optimization objectivesin order of priority.

Warnings detected by Metric Optimization might lead to misleading or undesirable results.

* No Improvement in Optimization
No routing inprovenent found: nmetrics unchanged
Metric Optimization was unable to improve on the metrics in the network. If the incremental option was

specified and latency bounds were enforced, this could be because the target metrics violated latency bounds
in ways that incremental optimization could not fix.

* Optimization Exit Diagnostics
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Optim zation performance may be linmted by | ow edge netrics

During the optimization, some desirable routes could not be selected because the given edge metrics would
have caused edge |eakage.

* Optimization Constraints Violated

» <n> \{intra. inter\site core metrics exceed \crlf \{intra, inter\site-metric \{ upper, lower\-bound

One or more intrasite or intersite core metric bounds have been violated.

» Maximum normal utilization exceeds specified bound
The original plan had normal utilization above the specified bound, and Metric Optimization was unable to
reducethe normal utilization below thisbound. If this occurs, Metric Optimization triesto set normal utilization

aslow as possible. No worst-case optimization is performed because reducing utilization under the normal
scenario is the highest priority.

* <n> demands with non-zero bandwidth exceed latency bounds
Because enforcing latency bounds is the highest optimization priority, this situation should not occur unless
alatency bound is less than the shortest possible latency for a demand.

 <n> demands with zero bandwidth exceed latency bounds
Metric Optimization does not always enforce latency bounds for zero bandwidth demands. These warnings
can occasionally occur even if it is possible to find lower latency paths for the signaled demands.

* Unrouted Demands

* <n> unroutable demands under normal operation

There are <n> demands for which no route exists between source and destination, even under the No Failure
scenario.

* <n> unroutable demands under <m> circuit failure scenarios
There are <n> demands for which no route exists between source and destination under <m> circuit failure
scenarios. (Different demands might be unroutable under different circuit failures.)

* <n> unroutable demands under <m> SRL G failure scenarios
There are <n> demands for which no route exists between source and destination under <m> SRLG failure
scenarios. (Different demands might be unroutable under different SRLG failures.)

* <n> unroutable demands under <m> source/dest node failure scenarios
There are <n> demands whose source and/or destination nodesfail under <m> failure scenarios. These demands

clearly cannot be routed in these circumstances. (Different demands might be unroutable under different node
failures.)

* <n> unroutable demands under <m> non-source/dest node failure scenarios
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There are <n> demands for which no route exists between source and destination under <m> node failure
scenarios, where the nodes that fail are intermediate nodes in the path of the demands, and are not
source/destination nodes of the demands. (Different demands might be unrouted under different nodefailures.)

Routing Summary

Summary statistics are displayed of the routes in network, both before (in parentheses) and after the
optimization.

* Core/Edge Max Utilization—The maximum percentage utilization over any interfacein the core or edge
network. The normal utilization is under the normal (no-failure) scenario, and the worst-case utilization
is maximized over all failure scenarios in the failure set.

* Latency—Median and averagelatencies over al routed demands, both in milliseconds and as a percentage
of the latency of the smallest latency route possible.

The latency of each demand's routing is calculated as a percentage of the latency of the shortest possible
route, by latency, for that demand. Under the percentage column, the median and average of these percentages
are displayed.

* Num of routes away from shortest path—The number of routes (out of al the demands routed) that do
not follow the shortest path, by latency. This statistic is an indicator of how much the routes have been
affected by utilization minimization as the primary criterion for optimization.

Metrics

The metric targeting choice is shown, together with the number of metrics different from the target metrics.
Lists of interfaces for which metrics differ from the target metrics are displayed, together with both the target
metric and the optimized metric. The metrics are separated into those on intrasite and intersite interfaces.
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